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1. Browsing Features of OntoBuilder

OntoBuilder was designed to work like a web browser. Figure 1 shows the OntoBuilder browser interface. To navigate to a page simply enter the URL into the address bar (e.g. www.avis.com) and press enter or click the “Go” button. By default OntoBuilder will use the HTTP protocol when no protocol is specified, so a URL such as www.avis.com will be automatically changed to http://www.avis.com. URLs can also be entered by means of common copy/paste commands either by right clicking on the address bar or using the hot-keys shortcuts; these shortcuts are compatible with the MS Windows standards (e.g. crtl-C for copy, crtl-V for paste, etc.).
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Figure 1. The OntoBuilder browser interface.
Once the “Go” button is clicked, the HTML page associated with the URL will be displayed in the “HTML View” panel. OntoBuilder maintains a history of visited URLs, which can be accessed using a combo box list in the address bar. The user can use the backwards and forwards buttons in the toolbox to navigate the history. The number of entries in the history is limited by an option in the tool options dialog as shown in figure 2. The history can be cleared (all entries in the history will be deleted) by clicking in the “Clear History” button.
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Figure 2. OntoBuilder browser options.
Other navigational aspects can also be set in the “Browser” options tab. The “Automatic META navigation” option is for pages containing redirection META tags such as the following:

<META HTTP-EQUIV=”Refresh” CONTENT="10; URL=http://www.another.com/">
By checking this option OntoBuilder will automatically load the URL specified in the URL attribute for the META tag.

The connection timeout indicates the amount of time to wait before abandoning a URL connection. By specifying -1 sec., OntoBuilder will use the system default connection timeout. This option is very useful for slow connection links.
OntoBuilder can also be directed to use a Proxy server for Internet connection. By specifying a proxy host and port, OntoBuilder will retrieve HTML pages through the proxy instead of a direct connection (the default). This option is very useful if running OntoBuilder behind firewalls.
OntoBuilder has support for HTML cookies, however cookies do not persist outside OntoBuilder wizard sessions. This means that cookies are persistent while retrieving an ontology using the ontology creation wizard, but once the wizard finishes the ontology generation, any cookie information will be lost.
2. Generating Ontologies

[image: image1.emf]

Once the web page for which we want to extract the ontology from is loaded in OntoBuilder, we can launch the “Ontology Creation Wizard” by selecting the appropriate submenu command under the “Ontology” menu, or by clicking the appropriate icon in the application toolbox, or by using the hot-key crtl-W. In order to show how the wizard works we will build a multi-page (by multi-page ontology we mean an ontology that is spread across multiple pages) ontology for the Avis.com web site. The first step of the wizard is shown in figure 3.
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Figure 3. The first step of the ontology wizard.

The ontology title defaults to the title of the HTML page and the ontology name defaults to the host from where the HTML page is retrieved. By clicking in the “Next: button we open the “Form Selection” dialog as shown in figure 4. In this dialog OntoBuilder will show all the HTML forms of the HTML along with their input elements. Since only one form can be submitted at a time while browsing a web page, the user is required to select the form he/she wants to submit from the forms listed under the “<form>” node in the “HTML Elements” panel on the upper left. Notice that this panel shows a hierarchical view of all the ontological structures of the HTML page.
By clicking on a node in the “HTML Elements” panel, all the attributes (default value, label, etc.) for the element represented are shown in the “Properties” panel in the lower left. Is worth noting that for HTML frame pages, the FORM elements will be located under the “<frame>” node in the “HTML Elements” panel.
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Figure 4. The “Form Selection” wizard dialog

The “Form Preview” panel is where the user will enter the required values for form submission. In order to determine what the required fields are we suggest simulating the process on one of the Internet browsers such as MS Internet Explorer or Netscape Navigator. Figure 5 shows the minimum required values for our Avis.com example.
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Figure 5. The reservation process in Avis.com

The same process must be simulated in OntoBuilder. Figure 6 shows the equivalent reservation in OntoBuilder. The only difference is that OntoBuilder doesn’t submit the form by clicking on the form submission button, but instead by clicking the “Next” button in the wizard.
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Figure 6. The reservation process in OntoBuilder
Failing to do the correct simulation in OntoBuilder will produce unexpected results (most of the times the web site will return a page indicating that some information is missing or return an error page with a brief description). Generally speaking, when using OntoBuilder to retrieve an ontology from a web application, the user must simulate the user interaction as if working in a common browser.
Returning to our example, the rest of the wizard forms are the same, except they will contain new form elements to be added to the final ontology. The rest of the process is very straightforward so we will just mention how to get to the end. There are four more pages (i.e. three more wizard dialogs) to retrieve the whole ontology, and in all four pages there is no required fields, default values will be enough. All the user is required to do is to select the appropriate form on the “HTML Elements” panel and simulate the form submission by clicking on the “Continue” button in each of the next three pages. The last page will allow to actually make the car reservation in Avis, as shown in figure 7.

[image: image7.emf]


Figure 7. Last step in the ontology creation wizard

During the wizard operation the user can use the “Back” button to go the previously submitted form, in case a mistake was detected. Once finished, the wizard will display the generated ontology on the “Main Panel”, as depicted in figure 8. The generated ontology can be saved in different formats by the appropriate commands in the “File” menu.
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Figure 8. The generated ontology

3. Entering the Right URLs in OntoBuilder

Some times, entering the same URL using in a common browser into OntoBuilder is not the most appropriate thing to do. Due to OntoBuilder limited HTML rendering capabilities, some URLs may not be correctly displayed (and thus, difficult to navigate).
As an example, consider the Alamo.com web site. By entering www.alamo.com in OntoBuilder we will see that it does a bad job in rendering the HTML page (see figure 9). No ontology will be generated from such URL. It is worth nothing that not always a bad rendering of the HTML page means that no useful ontology could be generated, some times OntoBuilder has trouble rendering the HTML page but the source code of it is retrieved correctly. Is recommended to run the ontology creation wizard even if a bad rendering occurs, in most cases the wizard will identify the form elements even if the HTML rendering didn’t work.
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Figure 9. An example of bad HTML rendering in OntoBuilder
In these cases, it is advised to use an Internet browser to actually navigate to the page where ontological structures may be identified. In the case of Alamo.com, by clicking in the “Rates & Reservations” button in the menu the browser will display the reservation form under the URL http://res.alamo.com. Figure 10 shows how this time OntoBuilder correctly identifies the form elements in the page.
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Figure 10. An example of correct HTML rendering in OntoBuilder

For HTML pages containing frames, it may be useful to “break” the frames using the URL in the frameset. As an example, the http://res.alamo.com URL is a HTML page containing frames (see the empty space in the upper section of the page in figure 10) and its source is the following:
<frameset rows="100,1*" frameborder="NO" border="0" framespacing="0"> 

  <frame name="topFrame" scrolling="NO" noresize src="topnav.asp">
  <frame name="mainFrame" src="http://res8.alamo.com/res/page1.asp">

</frameset>
In this case it may be better to enter the URL for the mainFrame frame (i.e. http://res8.alamo.com/res/page1.asp) in OntoBuilder, thus “breaking” the frame. Although OntoBuilder is designed to support frames (for an example load the NationalCar.com web site to see three levels of frames correctly handled by OntoBuilder), we suggest to follow the previous points when dealing with frames.
Most common Internet browsers will allow to see the source of an HTML page. By using OntoBuilder you can enable the “Source Panel” tab to see the HTML source of the loaded page. For this, check the “Source Panel” checkbox in the “View” tab of the OntoBuilder options dialog.
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Figure 11. View options for OntoBuilder
4. Troubleshooting Ontology Generation
Not all the web sites run as smoothly as the Avis.com site. Changes are you will not get a clean ontology at the first run. This is due to the complexity of most web sites designed using technologies not supported by OntoBuilder. At this time OntoBuilder doesn’t support any scripting at all. Current web sites rely on scripting for validation, automatic field filling, etc. As an example consider a page that has two fields Pickup Location and Dropoff Location, each with an assigned hidden field. By using scripting the web page automatically assigns the keyword same in the hidden field for the Dropoff Location, indicating that the dropoff location will be the same of the pickup location. All this is transparent to the user and also to OntoBuilder. If this page is loaded into OntoBuilder, the keyword won’t be assigned to the hidden field and thus the page won’t be submitted appropriately (the web site will return a missing information error message).
In this section we will explore some of the advanced techniques that will allow to discover what should actually be submitted when interacting with a HTML page loaded in OntoBuilder.

4.1 Identifying Errors

The first step is to actually identify that an error occurred. An error occurs if the information returned by the ontology creation wizard (forms) is different to the information returned by simulating the process on a normal Internet browser. There two ways to see what the error was: (i) by looking at the “HTML Page” tab in the ontology creation wizard, and (ii) by looking at the lastPageSubmitted.html HTML page in the current directory. Using any of the previous two methods we can try to identify some error message returned by the web server that will hint what the error is about (such as missing required fields, for example). The difference between the two methods is that former method relies on the HTML rendering capabilities of OntoBuilder, while the latter allows using any browser to see the returned page.
4.2 Testing for Submission Parameters and Headings
Some times is not quite obvious why we received an error page. A more advanced technique can be used to see if the information submitted to a web site is the right one. This technique requires little knowledge of HTML. Appended to this document there is a file called form.jsp. This JSP (JavaServer Page) page lists all the parameters submitted along with header information when the page is called from a form action attribute (either by GET or POST).
form.jsp must be installed in a web server with support for JSP applications. Tomcat is one of such servers. You can download Tomcat from http://jakarta.apache.org (it’s a free application). Instructions on how to install the Tomcat server can be found on the same web site under documentation. Once Tomcat is installed and running, we need to install our form.jsp page. The easiest way to install it is by copying the file in the HTML root directory for Tomcat (usually located in C:\Program Files\Apache Tomcat 4.0\webapps\ROOT). Advanced users may actually want to create a web context for this (see the Tomcat documentation on how to create web contexts). Tomcat is installed by default on TCP port 8080, so in order to call our JSP page we need to specify the following URL: http://localhost:8080/form.jsp.
The next step is to save the HTML page that is giving problems in the local computer so we will be able to edit the source code. By using Internet Explorer we can save the page to disk using the menu “File->Save As…”, or if it is a frame we want to save, by right clicking on the frame and then select “View Source” and saving the source to a file in disk. Open the saved page using any text editor and locate the FORM tag for the form that is giving the problem. Change the form action property to the URL for the form.jsp page as shown in Figure 12.
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Figure 12. Action URL change for Avis.com

Now load the saved page (with the action URL modification) using a browser, enter the values and submit the form. You should see a page similar to the one shown in figure 13, listing all the values submitted.
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Figure 13. The form.jsp page output

Now you can compare those values with the values presented in the “Last Submission” tab in the ontology creation wizard (see figure 14). Fill the values not submitted by OntoBuilder with the appropriate values as indicated by the form.jsp page and try again. Parameters ending with .x or .y are images parameters indicating the coordinate x and y where the user clicked; these parameters don’t need to have the same value but their presence is required.
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Figure 14. Parameters submitted by OntoBuilder

4.3 When Everything Else Fails
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So, you have tried every trick outlined in this document but is still not possible to get the ontology, then you can try one last thing: load the page from disk. By using any Internet browser, save the HTML page to disk and then open it in OntoBuilder using the “Open…” submenu of the “File” menu, and then use the ontology creation wizard as explained previously.

Using this technique is useful also for multi-page ontologies. Just use your Internet browser to interact with the web application and at each step save the HTML page to disk. Then use OntoBuilder to open each page individually and generate a partial ontology for each page. Next, save all the partial ontologies as XML files. Finally open the first XML ontology using any text editor and append all the text between the <terms></terms> tags (do not include these tags) of the other partial ontologies after the last </term> (and before the </terms> tag) of the first partial ontology. Figure 15 shows how this process works.
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Figure 15. Multi-page ontology merging
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